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Photo-Object Search Interface

NetGraphics Gallery allows you to quickly search for Photo-Object images through a simple and interactive 
interface. 

The interface is divided in two distinct areas: 

The top area is where searches can be issued by entering text that describe the images you are looking for, 
and/or simply selecting a category of interest. When a search criteria is entered, the textual description of 
the corresponding images is displayed in a list that can be scrolled. This list gives you the name of the 
Photo-Object images found along with a list of keywords that describe them. The first keyword in a Photo-
Object description corresponds to the category. Additional keywords were added to help you find images 
based on color, texture, material and other attributes. When a search is performed, the matching category, 
letters or words are highlighted in red, giving you instant feedback on why the displayed items were found 
as a result of the search.

The bottom area displays thumbnails of the Photo-Objects contained in the gallery or of the result from the 
last search performed. The thumbnails can be scrolled by using the scrollbar to the right of the thumbnails. 
The number of thumbnails simultaneously visible depends on the size of the window and the position of the 
splitter bar separating the top and bottom areas. Moving the splitter up will increase the number of visible 
thumbnails but will reduce the number of visible text descriptions. 



Tips
You can click on a Photo-Object text description to select and make visible its corresponding thumbnail, 
and vice-versa.

Double-click, right-click and drag & drop of a Photo-Object text description has the same effect as with a 
Photo-Object thumbnail.

For more information on searching for Photo-Objects images, click here.



What’s this product about?

Hemera NetGraphics Studio was specifically designed to help new and experienced Web authors in illustrating their 
Web pages. NetGraphics Studio mainly consists of a large collection of high quality photographic images combined 
with a powerful yet simple tool for exporting those images and most image formats to Internet compatible image 
formats.

NetGraphics Studio is composed of:

1. A large collection of photographic object images that we call Photo-Objects, as well as a PhotoFont Maker 
that allows you to create text with photographic textures.

2. An application named NetGraphics Gallery which allows you to quickly find the Photo-Objects or create 
the PhotoFonts of your choice.

3. An application called NetGraphics Optimizer which allows you to export Photo-Objects, PhotoFonts, clip 
art and other popular image formats to Internet compatible image formats.



NetGraphics Gallery application

The NetGraphics Gallery application is a revolutionary image search engine that allows you to search for a Photo-
Object image in a rapid and intuitive fashion. Its interface simultaneously displays Photo-Object image thumbnails 
and their associated name and description. Type in keywords that describe the images you are looking for, or simply 
select image categories and NetGraphics Gallery will instantly find the corresponding Photo-Object images! In 
addition, NetGraphics Gallery gives you the ability to create PhotoFonts. PhotoFonts are photographic textures that 
are instantly applied to the text you type.

Once you have found the desired Photo-Objects or created PhotoFonts, you can then quickly export them for the 
Internet using the NetGraphics Optimizer application.

Summary of Functionality:
Quickly and effectively search through thousands of images for use on your web pages.

Search images by name, attribute or category.

Create stunning text with PhotoFont Maker that applies photographic textures to the text you type. 

Quickly export Photo-Objects or PhotoFonts with a simple double-click or Drag & Drop to the 
NetGraphics Optimizer.

Export Photo-Objects or PhotoFonts with their transparency mask (32 bits/pixel including alpha channel) to 
professional applications such as Adobe Photoshop! 

For more details, see Contents of this online help.



NetGraphics Optimizer application

The NetGraphics Optimizer application allows you to transform Photo-Object images or any of your existing images 
into a format compatible with the Internet. Its interactive interface allows you to visualize and optimize every step of 
the process. You can visually and interactively resize images, see them combined with your background color or 
image tile, compress them to GIF or JPEG while you monitor image quality, file size and download time, apply 
Interlacing, and then insert them in your Web page using a simple Drag & Drop action.

Summary of Functionality:
Open most bitmap formats for export to an Internet compatible image format. Drag & Drop any of your 
existing graphics into this application and they will open.

Export vector clip art (WMF & EMF) files with automatic transparency generation.

Drag & Drop vector graphics opened in CorelDraw for automatic conversion to a bitmap format.

Visually and interactively resize and flip images.

Optimize transparent images for use on the background of your HTML page.

Visually and interactively apply compression and immediately see the resulting quality, file size and 
download time.

Interlace images with immediate feedback on file size and download time.

Export the resulting image to your Web Authoring Tool with a quick and simple Drag & Drop action.

For more details, see NetGraphics Optimizer’s online help.



What’s a Photo-Object?

A Photo-Object is a photographic image of a subject without its surrounding background. The subject has been cut 
out from the initially rectangular photograph such that it can be placed on any background and provide maximum 
visual impact. 

This image format is similar to other formats sometimes referred to as images with Transparency or images that 
have an associated Mask or Alpha Channel. But unlike typical photographic quality image formats that support 
transparency, Hemera’s Photo-Object image format (.HPI) uses little disk space which allows thousands of images to 
be contained on a single CD-ROM. 

Their high quality and resolution allows you to use them at virtually any size possible for the Internet or an Intranet. 
Photo-Objects are also totally background independent and, using NetGraphics Optimizer, can be perfectly 
optimized to your Web page background’s color or image tile, giving you the smoothest image edges possible (anti-
aliasing). Photo-Object images that suit your needs can be quickly found among our large collection with the help of 
the NetGraphics Gallery application.

Original photograph Photo-Object image
Photo-Object on a 

textured background

Technical Specifications:

Image Size: 600 x 600 pixels (on average)
Number of Colors Supported: 16.7 Million (24 bits for RGB)
Transparency Support: 256 Levels (8 bits per pixel alpha channel)
Total Image Depth: 32 bits per pixel



What are PhotoFonts?

PhotoFonts are photo-realistic characters or text created by combining text with a bitmap texture.

PhotoFonts can be created using PhotoFont Maker in NetGraphics Gallery.

Technical Specifications:

Image Size: Variable (depends on point size and text)
Number of Colors Supported: 16.7 Million (24 bits for RGB)
Transparency Support: 256 Levels (8 bits per pixel alpha channel)
Total Image Depth: 32 bits per pixel



Contacting Hemera Technologies Inc.

For technical support, see our technical support Web page at: http://www.hemera.com/techsupport.html or send us 
email at: support@hemera.com

For general inquiries, please send us email at info@hemera.com or visit our Web site at http://www.hemera.com.



Searching for a Photo-Object image

NetGraphics Gallery offers several different image search methods in one simple interface. Searches can be 
performed in any combination of the following methods:

Browsing Visually identify the image of your choice by scrolling through the Photo-Object 
thumbnails. You can also scroll through the list of Photo-Object names/descriptions. 

NOTE: You can click on a Photo-Object thumbnail to view its corresponding description 
and vice versa.

Search by Category Select a category by choosing it from the category list. When a category is selected, only 
thumbnails from that category can be browsed. To quickly jump to the next or previous 
category, click on the up or down arrow to the right of the category list box. 

Search by Keyword Enter keywords that describe the image(s) you are looking for. This allows you to quickly 
find the images whose description contains words that match the ones you enter.

When the option Match ALL words (AND) is selected, only the Photo-Objects that 
contain in their description ALL of the keywords you entered can be browsed. When 
using this option, the more keywords you enter, the less Photo-Objects you are likely to 
get.

When the option Match ANY word (OR) is selected, only the Photo-Objects that contain 
in their description ANY of the keywords your entered can be browsed. When using this 
option, the more keywords you enter, the more Photo-Objects you are likely to get.

A keyword search initially finds words of Photo-Object descriptions that begin with the 
text you enter until a space is entered, which then causes the whole word to be matched, 
thus eliminating words that were partially matched. 

Example: if you enter the text car, the search engine will find all words that begin with 
car, such as carrot, carnivore, carving and so on. If you only what cars (automobiles) to 
show, then follow the keyword with a space. This will show only Photo-Objects which 
have the word car in their description.

NOTE: If a category is selected, the keyword search will be performed on that category 
only.

Where’s the Search button?
NetGraphics Gallery’s search engine is so fast it doesn’t need a Search button. Photo-Object images are 
searched and displayed as you type the keywords to be searched or select categories, giving you instant 
feedback that will save you valuable time.

Tips
You can quickly narrow down your searches by entering keywords which correspond to attributes of the 
searched object such as its color, the material it is made of, its typical location, etc. For example, to search 
for a red car you would type: red car followed by a space or car red also followed by a space.    The 
leading space ensures that the last word you type is matched with a complete word in a description as 
opposed to matching words that begin with those characters.

To quickly cancel a search and start a new search, click the Clear Search button on the toolbar.



Exporting a Photo-Object image to a Web page

To export a Photo-Object or a PhotoFont image to a Web page, e.g. to an Internet compatible image format such as 
GIF or JPEG, use the Export to Internet command.



Exporting a Photo-Object image for use in other graphics packages

To export a Photo-Object or a PhotoFont image for use in other graphics packages, use the Pro Export command.



File menu commands

The File menu offers the following commands:

Export to Internet Exports selected Photo-Object or PhotoFont to the Internet using 
NetGraphics Optimizer

Pro Export Exports selected Photo-Object or PhotoFont to professional image 
formats

Run NetGraphics Optimizer Starts the NetGraphics Optimizer application
Exit Exits NetGraphics Gallery.



Edit menu commands

The Edit menu offers the following commands:

Clear Search Clears the current search text and automatically selects < All Categories>.
Add Texture... Inserts a new bitmap texture to the PhotoFont texture window.
Delete Texture... Removes selected thumbnail from the PhotoFont texture window.
Texture Properties... Edits properties of selected thumbnail from the PhotoFont texture window.



View menu commands

The View menu offers the following commands:

Toolbar Shows or hides the toolbar.
Status Bar Shows or hides the status bar.



Help menu commands

The Help menu offers the following commands, which provide you assistance with this application: 

Help Topics Offers you an index to topics on which you can get help.
www.hemera.com Goes to the Hemera Technologies Home Page.
Register Product Online Register your NetGraphics Studio through the Internet.
Online Technical Support Goes to the Hemera Technologies Technical Support Web page
About Displays the version number of this application.



Export to Internet (File menu)

This command opens the currently selected Photo-Object or PhotoFont with the NetGraphics Optimizer application. 
This provides a quick and easy way to export the selected image to an Internet compatible image format.

Shortcuts
Mouse: Double-Click a Photo-Object thumbnail or its text description.

Double-Click a PhotoFont or a PhotoFont texture.

Click the Export to Internet button  on the toolbar.

Right-Click a Photo-Object thumbnail or its text description and select Export to Internet... from the pop-up menu.
Right-Click a PhotoFont and select Export to Internet… from the pop-up menu.

Drag & Drop: Using the left mouse button, click and drag a Photo-Object thumbnail (or its text description) or a 
PhotoFont to the NetGraphics Optimizer. Release mouse button when mouse is over the image window of the 
NetGraphics Optimizer.



Pro Export (File menu)

This command allows advanced users to save a Photo-Object or a PhotoFont to a professional file format that 
supports transparency masks (Alpha channels). 

Photo-Objects or PhotoFonts exported with this command can then be used in other applications such as Adobe 
Photoshop, Corel PhotoPaint and Microsoft Image Composer to create special image compositions or 
transformations that suit your needs. 

Once your composition or transformation is complete, save or export the resulting image to the Targa (.TGA) or 
TIFF (.TIF) file format and then open it with the NetGraphics Optimizer for a quick and easy export to the Internet. 
If your transformed image still contains transparency information (alpha channel), then make sure you export it to a 
32-bit Targa or TIFF image format to preserve the transparency. This transparency information will be used by 
NetGraphics Optimizer to optimize the quality of the image to the background of your Web page. If your 
transformed image does not contain any more transparency information, then it should be exported to a 24-Bit Targa 
or TIFF image format.

Warning: If the application in which you import a Photo-Object or a PhotoFont image exported using this command 
does not support transparency masks, the transparency property of the image will be lost. This will cause the 
background around the object to appear.

Shortcuts

Mouse: Click the Pro Export button  on the toolbar.

Right-Click Photo-Object thumbnail or PhotoFont and select Pro Export... from the pop-up menu.



Run NetGraphics Optimizer (File menu)

This command simply starts up the NetGraphics Optimizer application. Unlike the Export to Internet command, no 
Photo-Object or PhotoFont image is opened after the application has started. You can then open any of your existing 
images for export to the Internet. 

Shortcuts

Mouse: Click the Run NetGraphics Optimizer button  on the toolbar.



Exit command (File menu)

Use this command to end your NetGraphics Gallery session.    You can also use the Close command on the 
application Control menu.    NetGraphics Gallery prompts you to save documents with unsaved changes.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



Clear Search (Edit menu)

Use this command to clear the last Photo-Object search performed. This allows you to quickly get rid of the text 
previously entered for a search and also resets the category list to <All Categories>.

Shortcuts

Mouse: Click the Clear Search button  on the tool bar.



Add Texture... (Edit menu)

Use this command to insert a new bitmap texture into the PhotoFont texture window.

Note: Added textures are copied to the Textures folder inside NetGraphic Studio’s folder. This allows you to freely 
move or delete your original texture without affecting PhotoFont Maker’s textures. 

Shortcuts
Mouse: Right-Click in the PhotoFont texture window, then select Add... from the popup menu.



Delete Texture... (Edit menu)

Use this command to remove a selected texture from the PhotoFont texture window.

Note: When deleting a texture image, only the copy that was made in the Textures folder (inside NetGraphic 
Studio’s folder) is deleted. If you have the original image elsewhere, that original image will not be deleted.

Shortcuts
Mouse: Right-Click the PhotoFont texture you want to remove, then select Delete... in the popup menu.



Texture Properties... (Edit menu)

Use this command to edit the properties of the selected PhotoFont texture.

Shortcuts
Mouse: Right-Click the PhotoFont texture for which you want to edit the properties, then select 

Properties... from the popup menu.



Toolbar command (View menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the most common commands 
in NetGraphics Gallery, such as File Open.    A check mark appears next to the menu item when the Toolbar is 
displayed.

See Toolbar for help on using the toolbar.



Toolbar

The toolbar is displayed across the top of the application window, below the menu bar.    The toolbar provides quick 
mouse access to many tools used in NetGraphics Gallery,

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

Click To

Export selected Photo-Object or PhotoFont to Internet.

Export selected Photo-Object or PhotoFont to a professional file format that supports transparency.

Run the NetGraphics Optimizer application (without any Photo-Object or PhotoFont).

Clear current text and category search.



Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be executed by the selected 
menu item or depressed toolbar button, and keyboard latch state. A check mark appears next to the menu item when 
the Status Bar is displayed.

See Status Bar for help on using the status bar.



Status Bar

The status bar is displayed at the bottom of the NetGraphics Gallery window.    To display or hide the status bar, use 
the Status Bar command in the View menu.

The left area of the status bar indicates how many Photo-Objects were found in the last search. When no search 
keywords are present and <All Categories> is selected, this number represents the total number of Photo-Objects in 
the gallery. When keywords are entered and/or a category is selected, this area displays the number of Photo-Objects 
found as a result of the search.

The right area of the status bar describes actions of menu items and toolbar buttons as you move you cursor over 
them. If after viewing the description of the toolbar button command you wish not to execute the command, then 
release the mouse button while the pointer is off the toolbar button.



Index command (Help menu)

Use this command to display the opening screen of Help.    From the opening screen, you can jump to step-by-step 
instructions for using NetGraphics Gallery and various types of reference information. 

Once you open Help, you can click the Contents button whenever you want to return to the opening screen.



www.hemera.com (Help menu)

Use this command to go to the Hemera Technologies Home Page and keep in touch with Hemera’s latest products, 
news and developments. 

NOTE: You must have a Web browser installed on your system as well as an Internet connection for this command 
to work.



Register Product Online (Help menu)

Use this command to go to the Hemera Technologies software registration Web page and register your copy of 
NetGraphics Studio.

NOTE: You must have a Web browser installed on your system as well as an Internet connection for this command 
to work.



Online Technical Support (Help menu)

Use this command to go to the Hemera Technologies Technical support Web page where you will find answers to the 
most frequently asked questions (FAQ) regarding technical support. If your question is still without an answer, send 
us Email at: support@hemera.com.

For other non technical inquiries, send us Email at: info@hemera.com.

NOTE: You must have a Web browser installed on your system as well as an Internet connection for this command 
to work.



Using Help command (Help menu)

Use this command for instructions about using Help.



About command (Help menu)

Use this command to display the copyright notice and version number of your copy of NetGraphics Gallery.



Context Help command 

Use the Context Help command to obtain help on some portion of NetGraphics Gallery.    When you choose the 
Toolbar's Context Help button, the mouse pointer will change to an arrow and question mark.    Then click 
somewhere in the NetGraphics Gallery window, such as another Toolbar button.    The Help topic will be shown for 
the item you clicked.

Shortcut
Keys: SHIFT+F1



Title Bar

The title bar is located along the top of a window.    It contains the name of the application.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging their title bars.

A title bar may contain the following elements:
Application Control-menu button
Document Control-menu button
Maximize button
Minimize button
Name of the application
Restore button



Scroll bar

Displayed at the right edge of the Photo-Object thumbnail window.    The scroll boxes inside the scroll bars indicate 
your vertical and horizontal location in the gallery or in the result from the last search.    You can use the mouse to 
scroll to other parts of the document.

To scroll one row of Photo-Object thumbnails at a time, click the up or down arrow of the scroll bar.

To scroll one page of Photo-Object thumbnails at a time, click in the gray area above or below the scroll box inside 
the scroll bar.

The scroll bar for the PhotoFont textures works in the same fashion.



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the arrow keys.

After the pointer changes to the four-headed arrow:

1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer to the border you 
want to move. 

2. Press a DIRECTION key to move the border.

3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or dialog box with the arrow 
keys.

Note:    This command is unavailable if you maximize the window.



Minimize command (application Control menu)

Use this command to reduce the NetGraphics Gallery window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note:    If you have multiple windows open for a single document, the Close command on the document Control 
menu closes only one window at a time.    You can close all windows at once with the Close command on the File 
menu.

Shortcuts
Keys: CTRL+F4 closes a document window

ALT+F4 closes the <<YourType>> window or dialog box



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the Maximize or Minimize 
command.



Switch to command (application Control menu)

Use this command to display a list of all open applications.    Use this "Task List" to switch to or close an application 
on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the following options:

Task List
Select the application you want to switch to or close.

Switch To
Makes the selected application active.

End Task
Closes the selected application.

Cancel
Closes the Task List box.

Cascade
Arranges open applications so they overlap and you can see each title bar.    This option does not affect 
applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not affect applications reduced 
to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



Creating a PhotoFont

PhotoFonts can be created using the PhotoFont Maker contained in NetGraphics Gallery. PhotoFont Maker allows 
you to quickly and easily create photo-realistic text.

To create a PhotoFont follow these steps:

1) Choose the PhotoFont tab in NetGraphics Gallery.
2) Type in the text for which you would like to create a PhotoFont.
3) Choose the desired font (any installed Windows True Type font can be used).
4) Choose your font size.
5) Choose the texture you would like to insert into your text from the available textures, or add your own 

textures by dragging and dropping them into the PhotoFont textures window. You can also add textures 
using the Add Texture... command.

6) Use the Export to Internet    command to optimize the PhotoFont for the Internet, or use the Pro Export 
command to export the image to professional graphics packages that support images with transparency 
(32 bits/pixels including alpha channel).

Tips
If the texture is not positioned the way you would like in respect to your text, try resizing the bottom right 
corner of the PhotoFont window. This will adjust the positioning of the texture within the text.

Try using different font sizes when adding your texture to see the effect. Some textures may look better in a 
larger font size. Once finished, the PhotoFont can be resized within NetGraphics Optimizer to suit your 
Web page.

If you want to view the PhotoFont image on the color of your choice, double-click it to bring it into 
NetGraphics Optimizer, go to the Background Color step and select the background color of your choice. 
While keeping NetGraphics Optimizer open, double-click on another texture to view the same text with the 
new texture in the Optimizer.



PhotoFont Maker Interface

NetGraphics Gallery allows you to quickly create PhotoFont images through a simple and interactive interface. 

The interface is divided into two distinct areas: 

The top area is where PhotoFonts can be made. You accomplish this by entering text, selecting a font, a 
style and a point size for which you would like to create a PhotoFont. When text is entered, the PhotoFont 
is created immediately.

The bottom area displays the PhotoFont. 

Tips
You can double-click a PhotoFont to Optimize it for the Internet.

For more information on creating and using PhotoFont images, click here.



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.

<< If you wish to author help specific to each message box prompt, then remove the AFX_HIDP_xxx values from 
the [ALIAS] section of your .HPJ file, and author a topic for each AFX_HIDP_xxx value.    For example, 
AFX_HIDP_INVALID_FILENAME is the help topic for the Invalid Filename message box. >>




